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	 	 �Using the navigation path 
Oracle Order Manage-
ment > Order Manage-
ment Super User > Setup 
> Parameters, select Item 
Validation Organization 
from the list of values 
(LOV) and save. Figure 1 
shows the resulting error 	
message.

	 	 �This is a classic error message 
throughout an Oracle 11i Receiv-
ables implementation. Improper 
configuration of this parameter 
impacts item selection in the 
transaction workbench and tax 
configuration, to name a couple.

 
	 	 �Before opening a Oracle Met-

aLink TAR, perform the follow-
ing steps, in order:

	 	 1. �Confirm you have selected the 
correct Item Validation Orga-
nization from the LOV for 
your operating unit.

	 	 2. �Recompile the AR schema; 
repeat until the error record 
count drops.

	 	 3. �Using ADADMIN, recompile 
all AR, JTF, and ONT forms 
and libraries.

	 	 4. �Manually recompile the Item 
Validation Parameter form 
and its associated PLS file.

	 	 5. �Relink the ONT and FND 
forms; relink the AR and FND 
forms.

	 	 6. Execute synonyms.

	 	 7. Re-test.

	 	 8. �If it still fails, open a SEV 2 
ESC TAR, as this is a show-
stopper for your Receivables 
implementation.

	 	 9. �Oracle Support will respond 
by asking you to run the AR 
Diagnostics Patch. If you have 
not installed this patch, do not 
waste your time, as it is not an 
easy install, has many pre-
requisites, and impacts both 
your technology stack and 
OA framework. Instead, ask 
Oracle Support to provide the 
SQL scripts that collect the 
same data as the Diagnostics 
utility.

Editor’s Note: The implementation of 
Oracle 11i Receivables does not have 
to be riddled with showstopper issues 
and numerous open TARs. With a 
little forward thinking, organization, 
and preparation, your project can 
roll out successfully. With any Oracle 
11i Receivables implementation, it is 
pretty much a foregone conclusion 
that issues will occur; but the good 
news is these issues occur for just 
about every Receivables project, are 
well documented, and are easily cor-
rected. Cheetah Solutions, a regular 
ORAtips contributor, walks the read-
er through the top ten implementa-
tion and testing issues associated 
with Oracle 11i Receivables. Now 
that’s “thinking Oracle.”

Introduction
This article will focus on the top ten 
Oracle 11i Receivables implementa-
tion and testing issues, and will pro-
vide the steps to take to correct them 
before opening an Oracle TAR.

	 1.	 ��Define Item Validation 	
Organization Parameter

	 	 �Oracle Receivables shares some 
common functionality with Ora-
cle Order Management

	 	 �The Item Validation Organiza-
tion parameter must indicate the 
operating unit that can be used 
for processing orders and returns 
if certain order / line attributes 
are not entered. Even if you are 
not using Order Management or 
do not have a multi-organiza-
tion configuration, this param-
eter must be defined for Oracle 
Receivables to function correctly 
as it impacts tax configuration.

Oracle® 11i Receivables Implementation Primer
By Cheetah Solutions

4On Financials 

Figure 1: FRM-40735 upon Form Save
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	 2.	 Define AutoAccounting
	 	 �You want to take advantage of 

AutoAccounting and enter a 
constant value for one or more 
of your organizations chart of 
accounts. Upon save, an error as 
shown in Figure 2 appears. 

	 	 �Believe it or not, the most likely 
cause for this issue is that the 
accounting flexfield segments se-
quence numbers are defined as 
10, 20, 30, 40, etc., instead of 1, 
2, 3, 4, etc. 

	 	 �Before opening a MetaLink TAR, 
perform the following steps, in 
order:

	 	 1. �Using the navigation path 
Oracle System Administrator 
> Application > Flexfields > 
Key > Segments, query your 
accounting flexfield structure.

 

	 	 2. �Change the segment 
numbers to one digit 
sequential numbers. 

	 	 3. �Save. Freeze and re-
compile the flexfield 
structure.

	 	 4. �Re-test.

	 	 5. �If it still fails, open 
a SEV 2 TAR, as 
this is not a showstopper 
for your Receivables imple-
mentation but definitely an 	
inconvenience.

	 	 6. �Oracle Support will respond by 
asking you about your setup, 
i.e., item validation param-
eter, system options, etc.

	 3.	 Define Customers
	 	 �Using the navigation path Oracle 

Receivables > Receivables Man-
ager > Customer > Standard, 

open the form. Figure 3 displays 
the result, which is another clas-
sic error message and one of 
my favorites because even sea-
soned Oracle consultants, myself 
included, usually forget to do 
both steps necessary to prevent 
this error from occurring.

 	 	 �Before opening a MetaLink TAR, 
perform the following steps, in 
order:

4On Financials 

Figure 2: AutoAccounting Error Message

Figure 3: FRM-40735 upon Open Form
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	 	 1. �Recompile the Location Flex-
field Structure in the System 
Options window. Yup, this is a 
key flexfield issue. 

	 	 		 �Using the navigation path Ora-
cle Receivables > Receivables 
Manager > Setup > System > 
System Options > Tax tab, go 
to the Location Flexfield Struc-
ture. 

	 	 		 �Remember when you defined 
your Sales Territory Flexfield, 
the default “State.County.
City” populated the field and if 
that is what you are using, you 
accepted it. 

	 	 �		 �The secret is to de-select, and 
then re-select the value from 
the LOV, and then save this 
form. Doing so kicks off five 
concurrent programs called 
“Flexfield PL/SQL Pre-Proces-
sors.” Ensure your concurrent 
manager is running and ensure 
these programs all complete 
successfully.

	 	

waste your time, as it is not an 
easy install, has many pre-
requisites, and impacts both 
your technology stack and 
OA framework. Instead ask 
Oracle Support to provide the 
SQL scripts that collect the 
same data as the Diagnostics 
utility.

	 4.	 �Tax Forms (Authorities, Loca-
tions, Sales Tax Rates, Exemp-
tions, Exceptions)

	 	 �So you have jumped ahead and 
did not read the first ORAtip, 
which was to define the Item Val-
idation Organization Parameter. 	
	
Now you have a tax form issue as 
shown in Figure 4. Guess what, 
even though the error message 
tells you to re-compile your 
Sales Tax Location flexfield both 
as a KFF and System Option, 
(and it’s not a bad idea), what 
you really need to do is go back 
to the first tip and ensure your 
Order Management configura-
tion is completed. Tax forms 

	 	 2.	�Next, re-compile the Sales Tax 
Location Flexfield in the Key 
Flexfield Segments window. 

	 	 		 �Using the navigation path Ora-
cle Receivables > Receivables 
Manager > Setup > Financials 
> Flexfields > Key > Segments, 
query the Sales Tax Location 
flexfield. Unfreeze, save, re-
freeze, and compile. This kicks 
off two concurrent programs 
called “Flexfield View Genera-
tor.” Ensure your concurrent 
manager is running and ensure 
these programs all complete 
successfully.

	 	 	3. Re-test.

	 	 4. �If it still fails, open a SEV 2 
ESC TAR, as this is a show-
stopper for your Receivables 
implementation.

	 	 5. �Oracle Support will respond 
by asking you to run the AR 
Diagnostics Patch. If you have 
not installed this patch, do not 
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Figure 4: AR-11254 Error upon Open Form
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depend on this step, and you 
cannot open any of the tax forms 
until it is properly defined. 

	 	 �Before opening a MetaLink TAR, 
perform the following steps, in 
order:

	 	 1.	�Using the navigation path 
Oracle Order Management 
> Order Management Super 
User > Setup > Parameters, 
ensure you have defined and 
saved the Item Validation 
Organization Parameter.

	 	 2. �Next, recompile the Loca-
tion Flexfield Structure in the 
System Options window. Yup, 
this is a key flexfield issue. 

	 	 		 �Using the navigation path 
Oracle Receivables > Receiv-
ables Manager > Setup > Sys-
tem > System Options > Tax 
tab, go to the Location Flex-
field Structure. 

	 	 		 �Remember when you defined 
your Sales Territory Flexfield, 
the default “State.County.
City” populated the field and 
if that is what you are using, 
you accepted it. 

	 	 		 �The secret is to de-select, and 
then re-select the value from 
the LOV, and then save this 
form. Doing so kicks off five 
concurrent programs called 
“Flexfield PL/SQL Pre-Pro-
cessors.” Ensure your con-
current manager is running 
and ensure these programs all 
complete successfully.

	 	 3.	�Next, re-compile the Sales Tax 
Location Flexfield in the Key 
Flexfield Segments window. 

	 	 		 �Using the navigation path 
Oracle Receivables > Receiv-
ables Manager > Setup > 
Financials > Flexfield > Key > 
Segments, query the Sales Tax 

Location flexfield. Unfreeze, 
save, re-freeze, and compile. 
This kicks off two concurrent 
programs called “Flexfield 
View Generator.” Ensure your 
concurrent manager is running 
and ensure these programs all 
complete successfully.

	 	 4. Re-test.

	 	 5. �If it still fails, open a SEV 2 
ESC TAR, as this is a show-
stopper for your Receivables 
implementation.

	 	 6.	�Oracle Support will respond 
by asking you to run the AR 
Diagnostics Patch. If you have 
not installed this patch, do not 
waste your time, as it is not an 
easy install, has many pre-
requisites, and impacts both 
your technology stack and 
OA framework. Instead ask 
Oracle Support to provide the 
SQL scripts that collect the 
same data as the Diagnostics 
utility.

	 5.	 Create Transactions
	 	 �Once customers and custom-

er sites are created and their 
relationships defined, it’s time 
to start creating transactions. 
Unfortunately, your customer 
bill-to location is not defaulting 
when you select a customer nor 
does the bill-to location LOV 
contain any values.

	 	 �This is another quirky example 
of contradictions Oracle Receiv-
ables introduces. All customers, 
regardless of whether you will 
be billing them for goods and 
services sold and shipped, must 
have a primary bill-to location 
defined.

	 	 �Before opening a MetaLink TAR, 
perform the following steps, in 
order:

	 	 1. �Using the navigation path 
Oracle Receivables > Receiv-
ables Manager > Customers > 
Standard, query the customer 
you were attempting to create 
a transaction for.

	 	 2. �Navigate to the Business Pur-
poses tab and note the usage 
setup. Does the customer have 
a primary, active bill-to usage 
and location defined? If not, 
check the primary checkbox.

	 	 		 �Note: If your customer has 
multiple sites, only one site can 
be the primary bill-to site. All 
other sites you should mark as 
active but not primary. Dur-
ing transaction creation, these 
sites will be available to select 
from the LOV.

	 	 3. Re-test.

	 	 4. �If it still fails, open a SEV 2 
TAR, as this is not a show-
stopper for your Receivables 
implementation but definitely 
an inconvenience.
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	 	 5. �Oracle Support will respond 
by asking you to run the AR 
Diagnostics Patch. If you have 
not installed this patch, do not 
waste your time, as it is not an 
easy install, has many pre-
requisites, and impacts both 
your technology stack and 
OA framework. Instead, ask 
Oracle Support to provide the 
SQL scripts that collect the 
same data as the Diagnostics 
utility.

	 6.	 �Create Transaction Line 
Items

	 	 �Now that the Bill-to and Ship-to 
business purposes primary and 
active checkboxes have been 
enabled for each customer and/
or customer site, you are ready 
to proceed with invoice creation. 
Unfortunately another problem 
surfaces as shown in Figure 5. 

	 	 �This error has occurred because 
you have enabled AutoAccount-
ing using the site G/L accounts 
to derive the receivables, tax, 
or revenue segment informa-

tion, but you forget to define the 
default accounts at the customer 
site level.

	 	 �Before opening a MetaLink TAR, 
perform the following steps, in 
order:

	 	 1.	�Using the navigation path 
Oracle Receivables > Receiv-
ables Manager > Customers > 
Standard, query the customer 
you were attempting to create 
a transaction for.

	 	 2.	�Navigate to the Business 
Purposes tab and open the 
Bill-to usage. Navigate to the 
Accounts tab and enter receiv-
able, revenue, and tax code 
combinations. Save.

	 	 		 �Note: If your customer has 
multiple sites, repeat for every 
site.

	 	 3. Re-test.

	 	 4. �If it still fails, open a SEV 2 
TAR, as this is not a show-

stopper for your Receivables 
implementation but definitely 
an inconvenience.

	 	 5.�  Oracle Support will respond 
by asking you to run the AR 
Diagnostics Patch. If you have 
not installed this patch, do not 
waste your time, as it is not 
an easy install, has many pre-
requisites, and impacts both 
your technology stack and OA 
framework. Instead ask Oracle 
Support to provide the SQL 
scripts that collect the same 
data as the Diagnostics utility.

	 7.	 Complete Transactions
	 	 �Congratulations, you have cre-

ated and saved your first trans-
action. Having read the Oracle 
11i Receivables User Guide, you 
know you need to complete the 
transaction if you want to print it, 
post it, or have it appear on your 
aging reports. You click the Com-
plete button. Nothing happens, 
but the message at the bottom 
of your window said one record 
saved and completed. But, wait a 
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Figure 5: Transaction Workbench AutoAccounting Error
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minute, should not the Complete 
checkbox in the upper-right cor-
ner of the transaction workbench 
window be checked and should 
not the Complete button now be 
the Incomplete button. You click 
again, and click again, and still 
the message tells you one record 
saved and completed. Oops. 

	 	 �This is a tricky issue that requires 
your Oracle Database Adminis-
trator involvement. The trans-
action workbench form and its 
associated libraries require re-
compiling.

	 	 �Before opening an Oracle Met-
aLink TAR, perform the follow-
ing steps, in order:

	 	 1.	�Recompile the AR schema; 
repeat until the error record 
count drops.

	 	 2. �Using ADADMIN, recompile 
all AR, and JTF forms and 
libraries.

	 	 3. �Manually recompile the trans-
action workbench form (ARX-
TWMAI) and its associated 
PLS file.

	 	 4. �Relink the AR and FND 
forms.

	 	 5. Execute synonyms.

	 	 6. Re-test.

	 	 7. �If it still fails, open a SEV 2 
ESC TAR, as this is a show-
stopper for your Receivables 
implementation.

	 	 8. �Oracle Support will respond 
by asking you to run the AR 
Diagnostics Patch. If you have 
not installed this patch, do not 

waste your time, as it is not an 
easy install, has many pre-
requisites, and impacts both 
your technology stack and 
OA framework. Instead ask 
Oracle Support to provide the 
SQL scripts that collect the 
same data as the Diagnostics 
utility.

	 	 		 �Tip: This solution will also 
resolve two other classic	
issues: creating and complet-
ing Credit Memos and select-
ing items or descriptions 
(standard memo lines) during 
invoice creation.

	 8.	 �Interface to General Ledger
	 	 �Transactions are entered, receipts 

applied, you are ready to post to 
the General Ledger. Using the 
navigation path, you submit the 
General Ledger Transfer process 
and click on View > Requests to 

monitor the concurrent manager. 
Shortly thereafter, the program 
completes with error, as shown 
in Figure 6, and the first stage in 
the request set Revenue Recog-
nition completes with warning. 
What happened? A quick glance 
at the log file tells little but does 
include a cryptic error mes-
sage. Like any good Oracle user, 
you type the error message into 
MetaLink’s search engine, which 
quickly returns with a solution. 
The print option for the Revenue 
Recognition concurrent program 
is enabled, which causes the 
General Ledger Transfer process 
to fail. 

 	 	 �Before opening a MetaLink TAR, 
perform the following steps, in 
order:

	 	 1.	�Using the navigation path 
Oracle System Administrator 
> Concurrent > Programs > 
Define, query the concurrent 
program “Revenue Recogni-
tion.” Scroll down to the one 
that has ARBARL_NON_SRS 
as its shortname.

	 	 2.	�Disable the print option and 
save.

	 	 3. Re-test.

	 	 4. �If it still fails, open a SEV 2 
ESC TAR, as this is a show-
stopper for your Receivables 
implementation. 

	 	 5. �Oracle Support will respond 
by asking you for concurrent 
program version information, 
which you can find by using 
the UNIX command grep to 
find the report header.

4On Financials 
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Figure 6: Concurrent Manager View Requests
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	 9.	 Print Invoices
	 	 �The next logical step in using 

Oracle 11i Receivables is print-
ing customer invoices. You navi-
gate to the Invoices sub-function, 
enter the concurrent program 
parameter information, and sub-
mit the request. Using the View 
> Requests menu, you watch 
your concurrent program com-
plete successfully and even view 
the output on screen. You go to 
the printer where a pile of blank 
paper greets you. Not what you 
were expecting. 

	 	 �This is another tricky issue 
that is easily resolved with the 
help of your Oracle System 	
Administrator.

	 	 �Before opening a MetaLink TAR, 
perform the following steps, in 
order:

	 	 1.	�Using the navigation path 
Oracle System Administra-
tor > Concurrent > Programs 
> Define, query the execut-
able “Transaction Print.” Five 
concurrent programs use this 
executable.

	 	 2. �For each validate, the print 
style is Invoice Print and the 
print option is enabled.

	 	 3. �Next, still within the Oracle 
System Administrator respon-
sibility, navigate to Install > 
Printer > Register. Query the 
name of the printer you will 
be using to print invoices, and 
document its associated print-
er type.

	 	 4. �Next, still within the Oracle 
System Administrator respon-

4On Financials 

sibility, navigate to Install 
> Printer > Type. Query the 
type of printer identified in 
step 3. Insert a new record, 
selecting from the list of val-
ues INVOICE as the printer 
style and the landscape driver 
for your printer. Save.	

	
	 	 5. Re-test.

	 	 6. �If it still fails, open a SEV 2 
ESC TAR, as this is a show-
stopper for your Receivables 
implementation.

	 	 7. �Oracle Support will respond 
by asking you to run the AR 
Diagnostics Patch. If you have 
not installed this patch, do not 
waste your time, as it is not an 
easy install, has many pre-
requisites and impacts both 
your technology stack and 
OA framework. Instead ask 
Oracle Support to provide the 
SQL scripts that collect the 
same data as the Diagnostics 
utility.

	 	 		 �Tip: If you want to suppress 
the header page from print-
ing, set the default value for 
Number of Alignment page to 
zero. This is a concurrent pro-
gram parameter for each of 
the concurrent programs that 
use the executable “transac-
tion print.”

	10.	Dunning Letters
	 	 �Custom Dunning Letters are 

easy to define, right? So why, 
then, does your Dunning Letter 
not print the customer’s invoice 
information? All the rest of the 
verbiage you entered is there as 
shown in Figure 7.

	
	

�Dunning Letters come pre-seeded 
with bind variables for invoices and 
collector information. The invoices 
will print on the Dunning Letter if 
you create a message line with the 
text “&INVOICE.” 

	 	 �Tip: Case is very important and 
must be UPPER.

	 	 �Before opening a MetaLink TAR, 
perform the following steps, in 
order:

	 	 1. �Using the navigation path 
Oracle Receivables > Receiv-
ables Manager > Setup > Print 
Documents > Dunning Let-
ters, query your custom letter.

Figure 7: Dunning Letter

If you want to 

suppress the header 
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	 	 2. �Position your cursor on the 
message line where you 
want invoices to print. Enter 
&INVOICE. Save.

	 	 3. Re-test.

	 	 4. �If it still fails, open a SEV 2 
TAR, as this is not a show-
stopper for your Receivables 
implementation but definitely 
an inconvenience.

	 	 5. �Oracle Support will respond by 
asking you about your setup, 
i.e., item validation param-
eter, system options, etc.

Conclusion
And there you have it. The top ten 
issues Oracle customers encountered 
when first implementing and test-
ing Oracle 11i Receivables. As you 
have read, most are easily resolved 
with very little assistance from Ora-
cle Support or your technical team. 
And following the steps at the time 
of implementation rather than wait-
ing to encounter the issue can avert 
many.      
                                         

Not all issues are 

showstoppers, the 

trick is knowing 

which ones to 

escalate…
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